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1. Introduction
Vista is located under the thermal group of applications within the IES Virtual
Environment. It is intended as a tool to quickly and easily analyse the results
from one or more simulations carried out using the thermal modelling tools.

The package reads ApacheCalc (CIBSE Heat Loss & Heat Gain Calculation),
ApacheLoads (ASHRAE Heat Balance Method Calculation), ApacheSim
dynamic thermal simulation files and real climate data files.

2. Vista View
The Vista application workspace consists of distinct areas of user input. They
are ordered vertically from top to bottom:

The main Vista menu:

The Vista toolbar provides shortcuts to opening new results files and plotting
new graphs or tables and is different for each type of file to be analysed:

Simulation files (*.aps):

Heating Loads (*.htg):

Cooling Loads (*.clg):

The model view area acts in the same way as in the other application
workspaces. That is, clicking onto a room selects it. If you double click a room, it
takes you down one decomposition level. You can navigate down to openings to
get air flow rates, etc. Please note that you can also use the model browser on
the left hand side of the screen to control what room is selected. If you select
outside the model or select “Model” on the browser, then the results for the
whole model are selected. The variables available for selection are different to
the individual rooms.
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Any change in selection of any part of the model is automatically reflected in the
dialog bar (in terms of what level of the model is selected) and in the last-
created graph or chart, in terms of which part of the model is used for results
analysis.

The view toolbar acts in the same way as other application workspaces allowing
you to control the level of decomposition of the model and what angle it is
viewed from.

The dialog bar has a number of input areas, with each one distinctly labelled.
These are described in more detail later in the manual. Suffice to say that, once
you have created a new graph or table, then when you change the selections in
this area of the screen, then the viewed output on the latest graph or table is
updated accordingly. This makes it easy to browse around a model and the
associated thermal results.
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3. Specifying Data for Output
The primary aim of Vista is to allow the user to obtain a graphical or tabular form
of results very quickly. Once a method of output has been selected from the
output toolbar, the latest chart dialog reflects any changes selected by the user.
As soon as you click onto a new results file or variable, that change should be
reflected in the display straight away, although there may be some delay when
large data quantities are being processed.

3.1. Specifying Results

When Vista is manually selected by the user, the system automatically loads
the results files stored in the Vista sub-folder of your project. If you wish to add
new files to look at, you can select File > Open from the Vista menu, or you
can click the Open File button in the Output toolbar. Any new files are added to
the simulation results files list at the bottom of the screen.

When Vista is called automatically at the end of a simulation run, you don't
need to specify the results file. The newly created file is opened automatically
for you. Results are sorted into the 4 main types; heating load results either
from ApacheCalc or ApacheLoads are shown in red text and have the suffix
*.htg, cooling load results either from ApacheCalc or ApacheLoads are shown
in blue text and have the suffix *.clg. ApacheSim dynamic thermal simulation
results are shown as black text and have the suffix *.aps, weather files (*.fwt or
*.epw) are shown with green text. The drop down box above the results can be
used to sort the different results.

When you want to specify a file to be used, just click onto it. All highlighted files
will be used for results display. You can deselect a file by just clicking onto it
again.

Results files are closed by selecting File > Close from the Vista menu. All
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currently highlighted files are closed, and removed from the file list.

3.2. Specifying Variables

All available variables are displayed in the dialog bar at the bottom of the
screen. There are two different types of variables: those for the model
simulation and those for the weather. The currently selected variables are
highlighted in the Single lists. The Multi-select lists are just ways of short-
cutting selecting various common combinations of single variables. If you
select None in the Multi-select box, it will clear all highlighted variables. To
deselect a single variable, click on it a second time.

3.2.1. Model Variables

These variables are obtained from the steady state calculations and Apache
simulation results files. When you navigate to different levels of the building, you will
notice the listed variables change.

When you are at the model level (i.e. more than one room is displayed), and at least
one room is selected, then the variables which are relevant to rooms are displayed.

When you can see more than one room, but no room is selected, or you click Model
on the Model Browser, then you can access the model level variables (total energy
loads, etc).

Air flow rates etc. can be accessed by navigating down to the surface level and
selecting an opening. This assumes that you have incorporated air flow into the
simulation using MacroFlo.
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3.2.2. Weather Variables

These variables are obtained from the weather file which is associated with a
specific simulation results file. As with the Model simulation variables, you can select
common groups of variables. The ‘None’ selection removes all previous selections.

The weather data is not extracted from the simulation file, but is instead extracted
from the weather file which is associated with a particular simulation. Individual
weather files can also be viewed separately.

3.3. Specifying Parts of the Building

You can use the view toolbar to control how you view the model, in the same
way as for other application workspaces such as ModelIT.

Please note that when the blue arrows (up/down) are clicked, then the
variables which are accessible will change accordingly.
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4. Using the Output Toolbar
The output toolbar is shown below the Vista menu.

Simulation files (*.aps):

The buttons are (from left to right):

 Open File
 Results file properties
 Cursor reset
 Layer properties
 X-Y chart
 Multiple Graph Room Plotter
 Data Table
 Snapshot
 Synopsis (min\mean\max)
 Range tests
 Monthly Totals
 Comfort Settings.
 Peak time table
 Peak day table
 Peak day graph
 Peak day graph autosave
 Model Viewer

Heating Loads (*.htg):

The buttons are (from left to right):

 Open File
 Results file properties
 Cursor reset
 Layer properties
 Building and System Loads report
 X-Y chart
 Multiple Graph Room Plotter
 Data Table
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 Synopsis (min\mean\max)
 Comfort Settings.
 Heating loads summary
 Radiator selection
 Model Viewer

Cooling Loads (*.clg):

The buttons are (from left to right):

 Open File
 Results file properties
 Cursor reset
 Layer properties
 X-Y chart
 Multiple Graph Room Plotter
 Data Table
 Snapshot
 Synopsis (min\mean\max)
 Range tests
 Monthly Totals
 Comfort Settings.
 Peak time table
 Peak day table
 Peak day graph
 Peak day graph autosave
 Room cooling loads summary
 Room cooling loads detail
 Air sizing summary
 System loads summary
 System loads detail
 Model Viewer

The Open File button has been described before, and is used to add sets of
results. The reset cursor button acts in the same way as for ModelIT. The other
buttons will generate a new chart/table and display it straight away,
incorporating the currently selected variables for the currently selected parts of
the building these will be explained in greater detail in later sections of this user
guide.
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When charts or tables are created, they are listed in the Charts List menu. You
can minimise a chart, and it will remain listed here. When you select it in the list
it will be displayed again. If you close a chart, it is removed from the list, and
completely removed from memory.

4.1. The Common Chart Dialog

The common chart dialog is used to accommodate the different displays and
manipulation for the displayed output. It will appear automatically when one of
the output buttons have been clicked on the Output toolbar.

The two main menu items in the common chart dialog are Output and Analysis.

4.1.1. Output Menu

This menu item allows you to:

Copy Copies the current output to the Windows clipboard for pasting into another application.
Save Saves the output to the relevant file format.
Print Prints the display directly to a selected printer.
Report Creates a HTML report when results are being viewed as a table.
Hide Minimises the chart so that it can be reactivated again by selecting the chart in the chart

list.
Close Destroys the chart and closes the window, removing it from the chart list.

4.1.2. Analysis Menu

This menu item allows you to change analysis/display options and has the same
differet options dependant on the results being viewed:

Set Dates Changes the days (or time) over which you want to look at results
X-Y Line Graph Changes the mode to an X-Y plot
Data Table Changes the display to the source data, displayed in tabular format
Snapshot Shows data at a specific time and date
Synopsis Summarises the data, in terms of minimum value, maximum value and mean

value over the currently selected period
Ranges Allows you to test the data over the currently selected dates

(above/below/between set values).
Monthly Totals Allows you to summarise data totals over calendar months. Primarily

intended for use with variables which are given in watts or kW
Peak time table Identifies the peak time for the selected variable and shows any coincident

variable data chosen in tabular form
Peak day table Identifies the peak day for the selected variable and shows any coincident

variable data chosen in tabular form
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Peak day graph Identifies the peak day for the selected variable and shows any coincident
variable data chosen in graphical form

4.2. X-Y Chart

The X-Y chart mode for the common chart dialog allows you to look at a
straightforward plot of the currently selected data. If you left-mouse click the
graph, you can set the dates for the analysis period. Right-mouse clicking
allows you to copy/save/print the graph.

If you have a large number of data selected, it is recommended that you
enlarge the window (which will resize automatically) to improve the area within
which the graph can be plotted.

4.3. Multiple Room Graph Plotter

This option enables the user to automatically plot several rooms and output
each graph to disk. Until the X-Y chart button is selected then this option is
inactive. Once the button becomes active, we can then click the button which
will execute the dialogue below:
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The user can select any number of rooms from the list of rooms provided (or
from the room browser) and then click the button labeled Multiple-Plot. Once
clicked, a graph for each room would be saved in an enhanced meta file
(*.emf) format which can easily be inserted to any reporting documentation.

Note Enhanced Meta File is a common vector based graphics format which
can be easily imported into most word processors, such as: MS Word, Open
Office etc.

By default, each file will be saved into a sub-folder of the <project>\Vista\ folder
called graphs and each file name will be pre-ceded with XY. Should you wish
to change these values then click the button labeled Change Output Options
which will execute the settings for automatic X–Y plot image and saving
window allowing you to customise these values:
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Note this window can also be executed from the menu item Settings >
Automatic Graph Saving

4.4. Data Table

This tabular mode allows you to inspect all of the constituent data for the
current selections of file, model item and variable. You can use the Output
menu to Copy, Save, Print, etc. You can copy the data to the clipboard and
paste it into a spreadsheet package, which should automatically drop the data
into row/column formats for further analysis. The Analysis > Set Dates menu
can also be used to change the analysis period.

If you have quite a few columns in the table, it is recommended that you
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enlarge the table manually to improve the appearance of what can be viewed.

4.5. Snapshot

This tabular mode shows the value of any selected variable for the date/time
specified:

The output can be copied, saved, etc. in the normal way, using the Output
menu.

4.6. Synopsis (min/mean/max)

This tabular mode does a quick analysis of the selected data in terms of
minimum, mean and maximum values, over the currently selected time period.
The times at which the limits are reached are displayed as well.

The output can be copied, saved, etc. in the normal way, using the Output
menu.

4.7. Range Tests

The range test mode is particularly useful if you want to test for certain
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conditions being met in the room of a building. It allows you to test how
frequently certain limits are exceeded. The following areas of this dialog are of
particular importance:

Variable Allows you to pick the single variable to be tested.
Test Type Allows you to select how the test is to be carried out (above certain

values, below certain values, or between set limits).
‘Above/below set points’ tests against the room heating and cooling
set points as defined in Room Conditions of the thermal template.

Values Specifies the limits to be used. The number of steps specifies the
number of equal graduations to be used between the specified limits.

Day/Time Specifies which week days are to be tested within the currently
selected period and also which times of day are to be included.
‘Occupied times only’ restricts the test to only times when there are
people in the room as defined by Occupancy gains in thermal
template.

Average, Shared hours (logical ‘OR’ test)

When the average, shared hours checkbox is ticked an additional row is added
to the bottom of the table displaying the sum of hours when at least one room
in the selection meets the range condition for each column.
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Whenever you change the Variable selection, the table at the bottom of the
dialog will be updated automatically. However, for other parts of the dialog, you
will need to click the apply button to update the range test table.

Note: Above/below set points, Occupied Hours only and Averaged, Shared
hours only available for room variables.

If you select more than 2 or 3 steps for the tests, then you may want to enlarge
the window to ensure that all the text is visible.

4.8. Monthly Totals

This mode for the common chart dialog will total all data values over a calendar
month, based on the simulation time step (default 1 hour). It is primarily
intended to total energy and load values as kWh values, allowing power
demand and usage to be analysed for the building elements.
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If several variables are selected, you may need to enlarge the window to allow
you to see all of the text.

4.9. Set Dates

The Set Dates dialog is used to set the start and finish dates for viewing in the
common chart dialog.

In the main month area of the dialog, if you left-mouse click a day, then that
day will be set as the start day to view. You can right-mouse click a day to set
that day as the end-day. Move between months using the list at the left of the
dialog. All currently selected days are displayed with a grey background.
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Click Default Dates to select the entire simulation period.

Click the blue single arrow (backwards or forwards) to move the whole
selected period by the same duration as the span between the start and end
days. That is, if you select 7 days of a month, and you click the Next Selection
single arrow button, then the selection will be moved forwards one week. If you
select a whole calendar month, and click the same button, then it will move the
whole selection one month forward.

Click the blue double arrow (backwards or forwards) to skip to the
corresponding month, in order to make a selection.

Any changes in this dialog will be immediately reflected in the associated
common chart dialog which is displayed at the time.

In the case of a Snapshot the date is taken to be the

4.10. Comfort

4.10.1. Comfort Settings

By selecting the comfort settings button on the Vista toolbar, the user is presented
with the dialog below, enabling them to define their comfort parameters. By default,
the comfort settings are initialised to sensible values.

From the drop down list provided, the user may choose from a pre-defined list or opt
to enter a customised value. Once the user is happy with their new settings, simply
click the Apply button to change the current settings/parameters.
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4.11. Peak Time Table

The peak time table takes a variable and shows produces a table that shows
the peak time of the peak value of that variable. Firstly the variables have to be
selected, this is done from the variables list, then after selecting the peak time
table button a dialog appears:

Once the peak variable has been selected the peak time table is shown as
below:

The drop down list at the top of the peak time table will change the peak
variable.
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4.12. Peak Day Table

The peak day table takes a variable and shows produces a table that shows
the peak day of the peak value of that variable. Firstly the variables have to be
selected, this is done from the variables list, then after selecting the peak day
table button a dialog appears:

Once the peak variable has been selected the peak day table is shown as
below:
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The drop down list at the top of the peak day table will change the peak
variable.

4.13. Peak Day Graph

The peak day graph takes a variable and shows produces a table that shows
the peak day of the peak value of that variable. Firstly the variables have to be
selected, this is done from the variables list, then after selecting the peak day
graph button a dialog appears:

Once the peak variable has been selected the peak day graph is shown as
below:
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The drop down list at the top of the peak day graph will change the peak
variable.

4.14. Heating Loads Summary

The heating loads summary button only appears if heat loss in ApacheCalc or
heating loads in ApacheLoads. This summary identifies the heating loads and
all the losses that make up the heating load on the room:
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4.15. Cooling Loads Summary

The cooling loads summary button only appears if heat gains in ApacheCalc or
cooling loads in ApacheLoads. This summary identifies the cooling loads and
all the gains that make up the cooling load on the room:
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4.16. Cooling Loads Detail

The cooling loads detail button only appears if heat gains in ApacheCalc or
cooling loads in ApacheLoads. This dialog identifies the cooling loads and all
the gains that make up the cooling load on the room for the currently selected
period.
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4.17. Air Flow Sizing Summary

The air flow sizing summary button only appears if heat gains in ApacheCalc or
cooling loads in ApacheLoads. This dialog identifies the air flows into all
chosen rooms.

4.18. System Cooling Loads Summary

The system cooling loads summary button only appears if heat gains in
ApacheCalc or cooling loads in ApacheLoads. This dialog identifies the loads
on the apache system that are used in the model.
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4.19. System Cooling Loads Detail

The system cooling loads detail button only appears if heat gains in
ApacheCalc or cooling loads in ApacheLoads. This dialog identifies the loads
on the apache system that are used in the model detailed by the current
selected time step.

4.20. Building and System Loads Summary

This summary creates a HTML report that shows a summary of both the heat
loss/heating loads and heat gains/cooling loads. An example of this output is
shown below:

IES Virtual Environment 5.4.0

Summary of building heating and cooling performance.

1. General Summary
Model Data Cooling Calculation Data Heating Calculation Data
Project file: "0511-02-
FormulaProfiles.mit"

Cooling results file: "0511-02-
FormulaProfiles.clg"

Heating results file: "0511-02-
FormulaProfiles.htg"

Model total floor area = 42.7 m² Calculated at 14:49 on 03/Nov/05 Calculated at 14:49 on
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03/Nov/05

Model total volume = 110.6 m³ Calc. Period: May - Sep Calc. Period: January

Number of rooms = 4

2. Building Heating Loads Summary
Room load (kW) Air heating load (kW) Boiler load

System
Heating plant sens. Hum. plant System air Aux mech vent (kW) (W/m²)

Main system 6.85 1.31 0.00 0.00 8.98 210.25

Auxiliary Mech Vent 0.00 0.00 0.00 0.00 0.00 n/a

Total 6.85 1.31 0.00 0.00 8.98 210.25

3. Room Heating Plant Loads
Conduction gain
(kW)

Ventilation gain (kW)

Room
Air
temp.
(C)

External Internal

Air system
input sensible
(kW)

Aux
mech
vent

Infiltration
Natural
vent

Heating plant
sensible load
(kW)

Test Room 19.00 -0.60 -0.00 0.00 -1.11 0.00 0.00 1.71

Test Room 19.00 -0.60 -0.00 0.00 -1.11 0.00 0.00 1.71

Test Room 19.00 -0.60 -0.00 0.00 -1.11 0.00 0.00 1.71

Test Room 19.00 -0.60 -0.00 0.00 -1.11 0.00 0.00 1.71

4. Building Cooling Loads Summary
Peak Room load (kW) System air clg. load (kW) Aux mech vent clg. load (kW) Chillers load

Day Date Cooling plant sens. Dehum. plant Sens. Lat. Sens. Lat. (kW) (W/m²)

Jul 16:30 5.07 0.00 0.00 0.00 0.00 0.00 5.33 124.81

5. System Cooling Loads

Peak Room load (kW)
System air clg.
load (kW)

Aux mech vent clg.
load (kW)

Chiller load

System

Day Date
Cooling plant
sens.

Dehum.
plant

Sens. Lat. Sens. Lat. (kW) (W/m²)

Main system Jul 16:30 5.07 0.00 0.00 0.00 0.00 0.00 5.33 124.81

Auxiliary Mech Vent May 00:30 0.00 0.00 0.00 0.00 0.00 0.00 0.00 n/a

6. Room Sensible Cooling and Air Flow Rates

6.1 System: Main system

(Supply air temperature difference: 8.0 K)

Room Peak Peak Space conditioning sensible (kW) Air flow rate (l/s)

Test Room Jul 16:30 1.5 160

Test Room Jul 14:30 1.2 128
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Test Room Jul 16:30 1.4 150

Test Room Jul 15:30 1.0 103

All rooms in system 5.2 541.4

7. Room Cooling Plant Loads
Peak Load (kW)

Room
Day Date

Air temp.
(C) Cooling plant

sensible
Dehumidification
plant

Cooling + dehum
plant

Test Room Jul 16:30 23.00 1.54 0.00 1.54

Test Room Jul 14:30 23.00 1.24 0.00 1.24

Test Room Jul 16:30 23.00 1.44 0.00 1.44

Test Room Jul 15:30 23.00 1.00 0.00 1.00
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5. General Settings
General settings for Vista can be set using the Settings menu items.

5.1. Graph Line Colours

This menu item executes the dialogue shown below:

From here we can customise the colour for each variable that is to be
displayed in the graph.

5.2. Units Display

By default, the units are displayed in metric format. To display then in an
alternative format, select the desired format from the main Virtual Environment
menu (Settings -> Preferences… -> Units):

5.3. Automatic Graph Saving

See section 3.3 Multiple Room Graph Plotter.
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6. Vista-Pro[BETA]

6.1. MacroFlow bulk airflow visualisation

Airflow results obtained from MacroFlow calculations are now visualised with arrows and values on
each opening.

6.2. Colour Coded Results in 3D model

6.3. DSM Results animations
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6.4. Wind Rose

A visual representation of the main wind directions for the chosen location. View settings for the wind
rose can be adjusted in Options dialog.
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6.5. Look & Feel

New look & feel features include tree representation of results data, colour coding for model shading
by result and Time / Day / Date animation selection.

The tree control for Vista-Pro[BETA] results allows multi-selection at different levels. Graph values
can be tracked with left mouse click selection.
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7. Vista Variables
The meanings of the Vista variables are defined below. Any variables appearing
in Vista that are not listed here are obsolete variables generated by earlier
versions of the software, and are identified as such by the tag ‘(obs)’ in the
variable name.

7.1. Weather Variables

Dry-bulb temperature: The external air temperature measured in a standard
meteorological screen.

Wet-bulb temperature: The temperature measured by a wet-bulb thermometer
in a standard meteorological screen.

External dew-point temperature: The dew-point temperature of the external air
(the temperature at which the air would become saturated if cooled)

Wind direction: The direction from which the wind is blowing, measured
clockwise from true north.

The wind speed measured at a height of 10m above the ground.

Direct radiation: The intensity (irradiance) of the solar beam emanating from
the sun's disc and the region of sky immediately around it, measured
perpendicular to the beam.

Diffuse radiation: The intensity (irradiance) of solar radiation emanating from
the sky, excluding that portion immediately around the sun, measured on the
horizontal plane.

Global radiation: The intensity (irradiance) of solar radiation falling on the
horizontal plane.

Solar altitude: The angular elevation of the centre of the sun's disc above the
horizontal plane.

Solar azimuth: The horizontal angle between the vertical plane containing the
centre of the sun's disc and the vertical plane running in a true north-south
direction, measured clockwise from true north.

Cloud cover: The proportion of the sky covered by cloud.

Atmospheric pressure: The pressure exerted by the atmosphere.

External relative humidity: The relative humidity of the external air (water
vapour pressure expressed as a percentage of saturated vapour pressure)

External moisture content: The moisture content of the external air (mass of
water vapour expressed as a fraction of mass of dry air)
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7.2. Model Level Variables

These variables are accessed by clicking on ‘Model’ in the browser. They are
organized in three groups: Loads, Energy and Carbon.

7.2.1. Loads

Room heating plant sens. load: The sum of the room heating plant sensible loads
for all rooms in the building.
ApHVAC room units heating load: When an ApacheHVAC system is in use, the
sum of the heating loads on all radiators and direct acting heaters.
Room hum. plant load: The sum of the room humidification plant sensible loads for
all rooms in the building.
System air heating load: The total of the system air heating loads for all Apache
Systems.
Aux vent heating load: The total auxiliary ventilation heating load for the building
(handled by Apache Systems).
ApHVAC heating coils load: When an ApacheHVAC system is in use, the sum of
the heating loads on all heating coils.
ApHVAC steam humidifiers load: When an ApacheHVAC system is in use, the
sum of the loads on all steam humidifiers.
Boilers load: The sum of the loads (outputs) for all boilers (in both Apache Systems
and ApacheHVAC systems).
ApHVAC heat pumps load: When an ApacheHVAC system is in use, the sum of
the loads on all heat pumps.
Room cooling plant sens. load: The sum of the room cooling plant sensible loads
for all rooms in the building.
ApHVAC room units cooling load: When an ApacheHVAC system is in use, the
sum of the cooling loads on all direct acting coolers and chilled beams.
Room dehum. plant load: The sum of the dehumidification plant sensible loads for
all rooms in the building.
System air sens. clg load: The total of the system air sensible cooling loads for all
Apache Systems.
System air lat. clg. load: The total of the system air latent cooling loads for the
building (handled by Apache Systems).
Aux vent sens. clg. load: The total auxiliary ventilation sensible cooling load for the
building (handled by Apache Systems).
Aux vent lat. clg. load: The total auxiliary ventilation latent cooling loads for the
building (handled by Apache Systems).
ApHVAC cooling coils load: When an ApacheHVAC system is in use, the sum of
the cooling loads on all cooling coils (including any latent component).
Chillers load: The sum of the loads (outputs) for all chillers (in both Apache
Systems and ApacheHVAC systems).
ApHVAC recovered sensible heat: When an ApacheHVAC system is in use, the
net sensible heat (or if negative, net sensible cooling) recovered by heat recovery
components.
ApHVAC recovered latent heat: When an ApacheHVAC system is in use, the net
latent heat (or if negative, net latent cooling) recovered by heat recovery
components.
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DHW heating demand: The total DHW heating demand at the hot water outlets (i.e.
excluding pipe and tank losses) calculated on the basis of a 50K temperature rise
from the cold water main.
CHP generated heat: The heat contributed by the CHP plant, if present. This heat is
assumed to be input at the same point as heat from boilers – i.e. upstream of
distribution losses.

7.2.2. Energy

Boilers energy: The total energy consumption for boilers (in both Apache Systems
and ApacheHVAC systems).
Chillers energy: The total energy consumption for chillers (in both Apache Systems
and ApacheHVAC systems).
ApHVAC direct acting heaters energy: When an APhvac system is in use, the
energy consumption for direct acting heaters.
ApHVAC direct acting coolers energy: When an APhvac system is in use, the
energy consumption for by direct acting coolers (direct acting heaters working in
cooling mode).
ApHVAC heat pumps energy: When an APhvac system is in use, the energy
consumption for heat pumps.
ApHVAC fans energy: The total energy consumption for fans (in both Apache
Systems and ApacheHVAC systems).
ApHVAC pumps energy: The total energy consumption for central plant pumps (in
both Apache Systems and ApacheHVAC systems).
ApHVAC HR & spray pumps energy: When an APhvac system is in use, the total
energy consumption for heat recovery components and spray pumps.
Ap Sys fans/pumps/ctrls energy: Energy consumed by fans, pumps and controls
within Apache Systems. Includes auxiliary energy, chiller heat rejection pump
energy, and pump energy associated with DHW and solar water heating systems.
PV generated electricity: Electricity generated by a photovoltaic system, if present.
Negative by convention.
Wind generated electricity: Electricity generated by a wind turbine, if present.
Negative by convention.
CHP generated electricity: Electricity generated by a CHP system, if present.
Negative by convention.

System electricity: The system electrical energy consumption.
System <fuel>: The system energy consumption associated with the named fuel. In
the case of grid displaced electricity includes a negative contribution from any
electricity generated by PV, wind turbine and CHP systems.
Total system energy: The total system energy consumption, calculated as the sum
of the energy consumptions for system components, or alternatively as the sum of
system fuel consumptions. Includes a negative contribution from any electricity
generated by PV, wind turbine and CHP systems.

Equipment electricity: Electrical energy consumption associated with equipment
gains (internal gains excluding lighting). This variable is not reduced by electricity
generation by PV, wind turbines and CHP systems
Equipment <fuel>: Energy consumption associated with equipment gains (internal
gains excluding lighting) using the named fuel. This variable is not reduced by
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electricity generation by PV, wind turbines and CHP systems
Total equipment energy: Total energy consumption associated with equipment
gains (internal gains excluding lighting). This variable is not reduced by electricity
generation by PV, wind turbines and CHP systems
Lights electricity: Electrical energy consumption associated with lighting. This
variable is not reduced by electricity generation by PV, wind turbines and CHP
systems.
Lights <fuel>: Energy consumption associated with lighting. This variable is not
reduced by electricity generation by PV, wind turbines and CHP systems.
Total lights energy: Total energy consumption associated with lighting. This
variable is not reduced by electricity generation by PV, wind turbines and CHP
systems.

Total electricity: Total electrical energy consumption for systems, lights and small
power. This variable is not reduced by electricity generation by PV, wind turbines
and CHP systems.
Total <fuel>: Total energy consumption for systems, lights and small power using
the named fuel. In the case of the ‘fuel’ grid displaced electricity – electricity
generated by PV, wind turbine and CHP systems – the variable is negative by
convention.
Total energy: Total energy consumption for systems, lights and small power.
Includes a negative contribution from any electricity generated by PV, wind turbine
and CHP systems.

7.2.3. Carbon

System elec. CE: Carbon emissions produced by system electrical consumption.
System <fuel> CE: Carbon emissions produced by consumption of the named fuel
by systems. In the case of grid displaced electricity includes a negative contribution
from any electricity generated by PV, wind turbine and CHP systems.
Total system CE: Total carbon emissions produced by systems. Includes a
negative contribution from any electricity generated by PV, wind turbine and CHP

Equipment elec. CE: Carbon emissions produced by electrical energy consumption
associated with equipment gains (internal gains excluding lighting).
Equipment <fuel> CE: Carbon emissions associated with equipment gains (internal
gains excluding lighting) powered by the named fuel.
Total equipment CE: Total carbon emissions associated with equipment gains
(internal gains excluding lighting).

Total electricity CE: Total carbon emissions associated with electrical energy
consumption for systems, lights and small power. This variable is not reduced by
electricity generation by PV, wind turbines and CHP systems.
Total <fuel> CE: Total carbon emissions associated with consumption of the named
fuel. In the case of grid displaced electricity – electricity generated by PV, wind
turbine and CHP systems – the variable is negative by convention.
Total CE: Total carbon emissions for the building and its systems. Includes a
negative contribution from any electricity generated by PV, wind turbine and CHP
systems.
Total CE ex equip: Total carbon emissions for the building and its systems,
excluding emissions associated with equipment (which do not feature in the
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emission calculations for the UK Building Regulations). Includes a negative
contribution from any electricity generated by PV, wind turbine and CHP systems.

7.3. Apache System Variables

These variables are accessed by selecting the Systems browser and clicking
on one of the Apache Systems in the list (but not an ApacheHVAC system if
one is present). They are organized in three groups: System, Energy and
Carbon.

Note that if results from a linked ApacheHVAC system were requested (see
Section 7), rooms served by such an ApacheHVAC system do not contribute to
the variables listed here.

7.3.1. System

Room heating plant sens. load: The sum of the room heating plant sensible loads
for all rooms served by the system.
Room hum. plant load: The sum of the room humidification plant sensible loads for
all rooms served by the system.
System air heating load: The (non-negative) sensible heat required to raise the
temperature of outside air to the specified supply temperature. Only applies when
the supply temperature is specified as 'Temperature From Profile'.
Aux vent heating load: For Auxiliary Ventilation air supplies, the (non-negative)
sensible heat required to raise the temperature of outside air to the temperature
specified. Only applies to those Auxiliary Ventilation air exchanges for which the
supply temperature is specified as 'Temperature From Profile'.
DHW heating demand: The DHW heating demand at the hot water outlets (i.e.
excluding pipe and tank losses) calculated on the basis of a 50K temperature rise
from the cold water main.
DHW boiler load: The DHW heating load at the boiler, after allowing for pipe and
tank losses and any contribution from a solar water heating system.
DHW solar heating system input: The heat input from the solar heating system, if
present. This is the amount by which the DHW boiler load is reduced by preheating
of the cold water supply by the solar water heating system.
DHW solar htg system tank temp: The mean temperature of water in the solar
heating system tank, if present.
DHW solar heat input: The heat input from the solar panel (if present) to the solar
heating system storage tank.
Boiler load: The load on the Apache System boiler, calculated as the sum of the
room heating plant and air heating loads (both system and aux mech vent) met by
the system, with an adjustment applied for distribution losses.
CHP heat contribution: The heat contributed to the Apache System by the CHP
system, if present. This heat is assumed to be input at the same point as heat from
the boiler – i.e. upstream of distribution losses.
Room cooling plant sens. load: The sum of the room cooling plant sensible loads
for all rooms served by the system.
Room dehum. plant load: The sum of the room dehumidification plant sensible
loads for all rooms served by the system.
System air sens. clg. load: The (non-negative) sensible cooling required to cool the
outside air to the specified supply temperature. Only applies when the supply
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temperature is specified as 'Temperature From Profile'.
System air lat. clg. load: The (non-negative) latent load incurred in lowering the
temperature of outside air to the specified supply temperature, calculated on the
basis of a maximum off-coil percentage saturation of 90%. Only applies when the
supply temperature is specified as 'Temperature From Profile'.
Aux vent sens. clg. load: For Auxiliary Ventilation air supplies, the (non-negative)
sensible cooling required to lower the temperature of outside air to the temperature
specified. Only applies to those Auxiliary Ventilation air exchanges for which the
supply temperature is specified as 'Temperature From Profile'.
Aux vent lat. clg. load: For Auxiliary Ventilation air supplies, the (non-negative)
latent load incurred in lowering the temperature of outside air to the temperature
specified, calculated on the basis of a maximum off-coil percentage saturation of
90%. Only applies to those Auxiliary Ventilation air exchanges for which the supply
temperature is specified as 'Temperature From Profile'.
Chiller load: The load on the Apache System chiller, calculated as the sum of the
room cooling plant and air cooling loads (both system and aux mech vent, sensible
plus latent) met by the system, with an adjustment applied for distribution losses.
System air flow rate: The total volume flow rate of air supplied by the system
(excluding auxiliary mechanical ventilation). In the case of a system of type Generic,
this is the total outdoor air supply.
System air supply temperature: The temperature of air supplied by the system to
the rooms.
System air supply moisture content: The moisture content of air supplied by the
system to the rooms.
Aux vent flow rate: The total volume flow rate of auxiliary ventilation supplied by the
system.

7.3.2. Energy

Boiler energy: The energy consumption of the boiler.

Boiler pump energy: The energy consumption of the boiler pumps.

Chiller energy: The energy consumption of the chiller.

Chiller heat rej. pump energy: The energy consumption of chiller heat
rejection pumps and fans.

System auxiliary energy: The auxiliary energy consumption of the system.

DHW & solar heating pump energy: The energy consumed by DHW and
solar heating system pumps.

7.3.3. Carbon

Boiler CE: Carbon emissions produced by the energy consumption of the
boiler.

Chiller CE: Carbon emissions produced by the energy consumption of the
chiller.

Chiller heat rej. CE: Carbon emissions produced by the energy consumption
of chiller heat rejection pumps and fans.

System auxiliary energy CE: Carbon emissions produced by the auxiliary
energy consumption of the system.
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DHW & solar heating pump CE: Carbon emissions produced by the energy
consumed by DHW and solar heating system pumps.

7.4. Room Variables

These variables are accessed by selecting a room or a set of rooms in the
browser or the building graphic.

Note that a room may be served by either an Apache System or an
ApacheHVAC system, if one is present (see Section 7).

Air temperature: The mean temperature of the air in the room.

Dry resultant temperature: The mean of the room air and mean radiant
temperatures.

Environmental temperature: A 2:1 weighted average of mean radiant
temperature and air temperature

Mean radiant temperature: The uniform temperature of an imaginary
enclosure in which radiant heat exchange with the human body would equal
the radiant heat exchange occurring in the room.

Dew-point temperature: The dew-point temperature of the air (the
temperature at which the air would become saturated if cooled).

People dissatisfied: An index that predicts the percentage of occupants
expressing dissatisfaction with the room thermal environment.

Predicted mean vote: An index that predicts the mean value of the votes of a
large group of occupants on the following 7-point thermal sensation scale: +3
hot +2 warm +1 slightly warm 0 neutral -1 slightly cold -2 cool -3 cold

Comfort index: An index predicting comfort within the space based on the
following scale:

1: very cold, danger

2: cold, shivering

3: cool, unpleasant

4: cool, acceptable

5: slightly cool/acceptable

6: comfortable, pleasant/cool

7: comfortable, pleasant

8: comfortable, pleasant/warm

9: slightly warm/acceptable

10: warm, acceptable

11: warm, unpleasant

12: hot, very uncomfortable

13: very hot, danger

14: unoccupied

15: non-sedentary
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Relative humidity: The water vapour pressure of the air expressed as a
percentage of the saturation vapour pressure.

Moisture content: The water vapour content of the air (mass of water vapour
expressed as a fraction of mass of dry air).

Room CO2 concentration: the volumetric concentration of carbon dioxide in
the room (parts per million).

Space conditioning sensible: Sensible heat (or if negative, cooling) supplied
to the room by its Apache System or ApacheHVAC system. This consists in
general of two terms: a contribution from the room conditioning plant (or HVAC
radiators, direct acting heaters and chilled beams) and a contribution from the
system air supply.

Steady state heating plant load: Heating plant sensible load calculated under
steady state conditions by CIBSE Loads (heating plant sensible load is
calculated from this by application of an intermittency factor).

Heating plant sensible load: Sensible heating (non-negative) supplied to the
room by its Apache System room conditioning plant or ApacheHVAC room
units (radiators, direct acting heaters and chilled beams)

Cooling plant sensible load: Sensible cooling (non-negative) supplied to the
room by its Apache System room conditioning plant or ApacheHVAC room
units (radiators, direct acting heaters and chilled beams).

Internal gain: Sensible heat (or if negative, cooling) supplied to the room by
equipment, lights, people and other heat sources specified as Internal Gains.

Solar gain: Solar radiation absorbed on the internal surfaces of the room, plus
solar radiation absorbed in glazing and transferred to the room by conduction.

External conduction gain: Heat conducted into (or if negative, out of) the
room through the internal surfaces of externally exposed elements, including
ground floors.

Internal conduction gain: Heat conducted into (or if negative, out of) the
room through the internal surfaces of wall partitions, internal floors/ceilings and
elements with adjacent condition 'Temp from profile' or 'Outside air with offset
temp.'.

Conduction gain: Combined external and internal conduction gain (CIBSE
Loads only)

Air system input sensible: The sensible heat gain (or if negative loss) from
the air system. In the case of an Apache System of type Generic, this is the
sensible gain from the (possibly conditioned) outdoor air supply.

Aux vent gain: The sensible heat gain (or if negative loss) from Auxiliary
Ventilation air exchanges.

Natural vent gain: The sensible heat gain (or if negative loss) from Natural
Ventilation air exchanges.

Infiltration gain: The sensible heat gain (or if negative loss) from Infiltration air
exchanges.

MacroFlo ext vent gain: The sensible heat gain (or if negative loss) from
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MacroFlo-calculated air flows entering the room from the external environment.

MacroFlo int vent gain: The sensible heat gain (or if negative loss) from
MacroFlo-calculated air flows entering the room from adjacent rooms.

System air supply: The air supply associated with the system. In the case of
an Apache System of type Generic, this is the outdoor air supply.

Aux mech vent: The flow of air into the room from Auxiliary Mechanical
Ventilation air exchanges.

Natural vent: The flow of air into the room from Natural Ventilation air
exchanges.

Infiltration: The flow of air into the room from Infiltration air exchanges.

MacroFlo ext vent: The sum of MacroFlo-calculated air flows entering the
room from the external environment.

MacroFlo int vent: The sum of MacroFlo-calculated air flows entering the
room from adjacent rooms.

Space conditioning latent: The latent heat equivalent of water vapour added
to (or if negative, removed from) the room by its Apache System or
ApacheHVAC system. This consists in general of two terms: a contribution
from the room conditioning plant (or HVAC radiators, direct acting heaters and
chilled beams) and a contribution from the system air supply.

Humidification plant load: The (non-negative) latent heat equivalent of water
vapour added to the room by its Apache System room conditioning plant (if
present).

Dehumidification plant load: The (non-negative) latent heat equivalent of
water vapour removed from the room by its Apache System room conditioning
plant (if present).

Cooling + dehum plant load: the sum of cooling and dehumidification plant
loads.

Internal latent gain: The latent heat equivalent of water vapour added to (or if
negative, removed from) the room by equipment, people and other heat
sources specified as Internal Gains.

Equipment latent gain: The internal sensible gain from equipment.

People latent gain: The internal sensible gain from people.

Number of people: The number of people in the room.

DHW heating demand: The DHW heating demand at the room’s hot water
outlets (i.e. excluding pipe and tank losses) calculated on the basis of a 50K
temperature rise from the cold water main.

Air system input latent: The latent heat equivalent of water vapour added to
(or if negative removed from) from the space by the air system. In the case of
an Apache System of type Generic, this is the latent gain from the (possibly
conditioned) outdoor air supply.

Vent/infiltr. latent gain: The combined latent heat gain (or if negative loss)
from Auxiliary Mechanical Ventilation, Natural Ventilation and Infiltration air
exchanges.
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Aux vent lat gain: The latent heat gain (or if negative loss) from Auxiliary
Ventilation air exchanges.

Natural vent lat gain: The latent heat gain (or if negative loss) from Natural
Ventilation air exchanges.

Infiltration vent lat gain: The latent heat gain (or if negative loss) from
Infiltration air exchanges.

MacroFlo ext vent lat gain: The latent heat gain (or if negative loss) from
MacroFlo-calculated air flows entering the room from the external environment.

MacroFlo int vent lat gain: The latent heat gain (or if negative loss) from
MacroFlo-calculated air flows entering the room from adjacent rooms.

Convective room plant load: The convective component of the sensible heat
input from Apache System room conditioning plant or ApacheHVAC room units
(provided as an input to MicroFlo).

Convective lighting gain: The convective component of the sensible heat
input from lights (provided as an input to MicroFlo).

Convective equipment gain: The convective component of the sensible heat
input from equipment (provided as an input to MicroFlo).

Convective people gain: The convective component of the sensible heat
input from people (provided as an input to MicroFlo).

7.5. Surface Variables

These variables are accessed by selecting a room surface or opening (window
or door) in the browser or the building graphic.

Surface temperature: The temperature of the inner surface of the element.

Incident solar flux: The solar flux (irradiance) incident on the surface.

Incident solar power: The solar power (area-integrated irradiance) incident on
the surface.

Volume flow in: The volume flow entering through a MacroFlo opening.

Volume flow out: The volume flow leaving through a MacroFlo opening.

Mass flow in: The mass flow entering through a MacroFlo opening.

Mass flow out: The mass flow leaving through a MacroFlo opening.

Aero/Eqv area: The aerodynamic (or equivalent) area of a MacroFlo opening.
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8. ApacheHVAC Results

To view HVAC results in Vista, the ApacheHVAC link must be selected on the
Apache Simulation dialog and ApacheHVAC system results must be selected in
Output Options:

In Vista, select Systems in the Model browser, then the ApacheHVAC system
will be visible as the last System in the list, called ‘ApHVAC: <asp file>’.
Selecting this will give you a view of the ApacheHVAC network schematic.
The asp filename will be appended to the Vista filename in the title bar.

8.1. Component Variables

This is the default mode and is entered by choosing ‘HVAC – Select
Components’ from the interrogation dropdown list.

Results can be viewed for only a subset of all the ApacheHVAC components,
namely coils, fans and rooms. Those components for which results are available
are listed in the browser and selectable either there or on the schematic. Other
components on the schematic are not selectable.

As in ApacheHVAC itself, multiple components can be selected by drawing a
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rectangle, or by using Ctrl-click.

For room components, all the room variables as listed in Section 6.4 are
applicable. For coil and fan components the only variable that is applicable is
“Air Enthalpy addition”, which represents the load across the component.

8.2. Node Variables

This mode is entered by choosing ‘HVAC – Select Nodes’ from the interrogation
dropdown list. Nodes represent ducts in the network, and appear as numbers
(10, 20, 30…). A long duct will have its node number repeated at each end.

Nodes appear only on the schematic and not in the browser.

To select a node simply click on or near its number, or anywhere on the duct. In
a complex network you may find that you have to select within the nearest
component, rather than on the node number, to home in on the right node.

As for components, multiple nodes can be selected by drawing a rectangle, or
by using Ctrl-click.

The variables that are available for Nodes are: Mass Flow, Air Temperature,
Moisture Content, CO2 Concentration, Volume Flow, Wet-bulb Temperature
and Relative Humidity.

8.3. Multiplex Results

Results of any Multiplexed ApacheHVAC system can be viewed in Vista as
normal. Select Components or Nodes within the Multiplex to view detailed
results. Click within the Multiplex then change the Layer dropdown to the layer
you are interested in.
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To view the results for multiple layers on the same graph use the Lock
Variables tool then switch layer. Lock the results for as many layers as
required in this way.
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